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To Upgrade WorldShip: 
1. Review this document. 

2. Follow the Pre-installation Integration Checklist. 

3. Schedule a convenient time for the upgrade. 

4. Upgrade using the supplied CD. 

5. Follow the Post-installation Integration Checklist. 

Integrating WorldShip into Your Business 
WorldShip integration features enable you to connect the information from your current business 
system with WorldShip.  

Leveraging data from your systems to process shipments enables you to reduce key entry to 
improve consistency and accuracy. WorldShip also enables you to export shipment data back to 
your business system to shorten your billing cycle and improve customer service with updated 
tracking information.  

2012 New Integration Features 

Import and Export of New Services — Now the Import/Export Wizard and Connection 
Assistant support the import and export of the following: 

 Dangerous Goods — The Dangerous Goods Option, Dangerous Goods Type, Dangerous 
Goods Published Charge, Dangerous Goods Negotiated Rates Charge and Dangerous 
Goods CCC Rates Charge can be exported at shipment level and Dangerous Goods Type 
can now be exported at package level. 

 Origin and Destination Area Surcharges — The Origin Area Type, Origin Area Surcharge 
Published, Origin Area Surcharge CCC, Origin Area Surcharge Negotiated, Destination 
Area Type, Destination Area Surcharge Published, Destination Area Surcharge CCC and 
Destination Area Surcharge Negotiated can be exported at shipment level. 

 Ground Freight — The following Freight Shipment Information fields can be 
imported/exported:  

– Extreme Length 

– Freezable Protection 

– Limited Access Delivery (replaces Construction Site Delivery) 

– Limited Access Collection 

– Collection Notification for LTL Shipment 

– Collection Notification Reference Number 

– Collection Notification Reference Type 

– Collection Notification Company Name 

– Collection Notification Failed Email Address 
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The following Freight Shipment Information fields can be exported:  

– Extreme Length Charge 

– Freezable Protection Charge 

– Limited Access Charge (replaces Construction Site Delivery Fee) 

In addition, the following fields can be imported/exported for up to five recipients:  

– Collection Notification Email Address 

– Collection Notification collection Scheduled 

– Collection Notification Driver En Route 

– Collection Notification Exception 

– Collection Notification collected 

 Paperless Document Enhancements — The Print Copy of Paperless Documents Indicator 
and Process as Paperless fields can be imported/exported. 

 Residential Surcharge — The Residential Surcharge Published, Residential Surcharge 
CCC and Residential Surcharge Negotiated can be exported at shipment level. 

 Rates — The Negotiated Rates Indicator can be exported. 

 UPS Returns® Exchange on Outbound Label — The UPS Returns Exchange UPS Driver 
Instruction can be imported/exported. 

2011 New Integration Features 

Import and Export of New Services — Now the Import/Export Wizard and the Connection 
Assistant support the import and export of the following: 

 Import Control and Commercial Invoice Removal 

 Refrigeration 

 UPS Returns® Flexible Access 

 UPS carbon neutral 

 UPS Returns® Exchange 

 UPS Returns® Pack and Collect 

Import Control Enhancements — Now you can import Quantum View Notify® Notification for 
UPS Returns® services at both the shipment level and package level; before it was available 
only at the package level. Also, now you can import or export Label Creation, a new Quantum 
View Notify Notification type for all UPS Returns services, at the shipment level. Finally, 
importing or exporting Return Notification at the package level is no longer supported. 

Importing Pro Number into Freight — Now you can use the shipper pre-assigned Pro 
Number throughout shipment processing to uniquely identify your shipment from its creation to 
its destination. 
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Pre-installation Integration Checklist 

1. Check Compatibility: 

You may have integrated WorldShip with a UPS Ready® (or third-party) vendor application. Due 
to changes in the WorldShip database structure, these applications may not be compatible with 
WorldShip 2012.  

Do not upgrade until you contact the UPS Ready (or other third-party) vendor. 

2. Check Operating System and Service Pack: 

The WorldShip 2012 upgrade requires that you have either Microsoft® Windows® XP Service 
Pack 2 or higher or Microsoft Windows Vista®/Windows 7 to begin installation. 

To identify which Operating System and Service Pack you have: 

 Click Start on the Windows taskbar, point to Programs, Accessories and System Tools 
and select System Information. 

 The Operating System version and Service Pack will display in the System Information 
window. 

 If you have Microsoft Windows XP and the Service Pack is lower than version 2, select the 
link below to download and install the Service Pack. The PC will be evaluated for available 
updates by Microsoft. Microsoft Windows XP Service Pack 2 will appear as a critical update. 
http://WindowsUpdate.Microsoft.com.  

 If you wish only to install Microsoft Windows XP Service Pack 2, clear all other updates 
offered. 

Memory recommendations:  

 Windows XP (512 MB)  

 Windows Vista (1 GB) 

 Windows 7 (1 GB - 32 bit and 2 GB - 64 bit) 

CAUTION: Do not proceed if your system is not at the proper Operating System and Service 
Pack version. 

3. Check for Administrative Rights: 

Ensure that the user account used to log into Microsoft Windows operating systems has full PC 
administrative rights. If unsure, consult the computer technical support staff at your company. 
Due to security enhancements, Microsoft Windows Vista/Windows 7 users may be required to 
authenticate with administrative rights during the installation process. The User Account Control 
(UAC) prompt may appear several times during installation asking you for permission to let 
WorldShip install its components. You must acknowledge the UAC prompt and allow the 
installation to continue. 

Also, if you need to access the WorldShip Support Utility for any reason, you must run this utility 
with administrative rights. To perform this task: 

 Click Start on the Windows taskbar, point to Programs and UPS, right-click on UPS 
WorldShip Support Utility and select Run As Administrator. 
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4. Archive WorldShip Shipping History to Improve Performance and Processing: 

 Start WorldShip. 

 Press F3 to open the Shipment History window. 

 On the File menu, select Archive Shipments. 

 In the Archive Shipments window, select All Shipments, or select All Shipped On or Before 
and specify a date range, and then click on OK. 

 In the Save As window, click on Save. 

 Click on Yes in the confirmation window.  
Note: The last 14 days of history will not be deleted, and the history that is deleted may be 
restored at any later time when needed. 

 Click on Done when 100% is reached in the Archive Shipments window. 

 Click on Yes in the window that appears requesting the database backup to be performed. 

5. Check for and Disable Anti-Spyware, Anti-Malware and Virus Scanner Software: 

Anti-spyware, anti-malware, and virus scanner software may conflict with the WorldShip 2012 
installation. 

6. Check for Workgroup Setup Concerns: 

 Only one WorldShip Workgroup Administrator is allowed. 

 Only the Workgroup Administrative workstation’s language will be available for Workgroup 
Remote workstations. If a Workgroup Remote workstation has a need for a WorldShip 2012 
installation in another language, the user will need to install as a Single workstation and 
should be cautioned that this workstation will not benefit from Workgroup-configurable 
functionality. 

 You may need to configure the firewall software on the Workgroup Administrative 
workstation so the Workgroup Remote workstations can connect. See the Post-installation 
Integration Checklist section for more details. 

7. Shut Down Open Applications: 

Shut down all other programs running on the taskbar, including Microsoft Outlook®, Internet 
Explorer®, Excel®, etc. 

You are now ready to install. Please insert the WorldShip 2012 CD into your computer, the 
upgrade will automatically start if your system supports the auto-run feature. If you need 
information on how to upgrade/install, refer to the Support Guides section. 

CAUTION: Microsoft Windows Vista/Windows 7 users please read below. 

At the completion of the WorldShip installation process, your PC will be required to restart. After 
restart, Microsoft Windows Vista/Windows 7 may prevent automatic launching of the WorldShip 
application. Please launch WorldShip using the icon on your desktop should this happen. If you 
chose not to place the WorldShip icon on your desktop, you may launch WorldShip by clicking 
on Start on the Windows taskbar, pointing to Programs and then UPS and selecting UPS 
WorldShip. 
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Post-installation Integration Checklist 
1. After the installation, you may need to allow permissions in your firewall for the following files 

to run and ports to accept inbound and outbound traffic. 

 Files that may need permission to run are GetHostIP.exe, WorldShipTD.exe, 
wstdsupport.exe, upslnkmg.exe and sqlservr.exe. 

 Ports that may need Inbound and Outbound traffic access are 80 and 443. 

 Configure the firewall software on the Workgroup Administrative workstation so the 
Workgroup Remote workstations can connect. 

– If you use the Windows XP Service Pack 2 firewall, WorldShip will configure the firewall 
for you. 

– If you use another firewall, the following settings should be configured: 

 UDP Port 1434 should be open to incoming traffic 

 The WorldShip database instance <drive>:\UPS\WSTD\ 
MSSQL$UPSWSDBSERVER\Binn\sqlserver.exe should  
be included in the list of firewall exceptions.  

2. If you disabled any anti-spyware, anti-malware or virus scanner software, please 
enable it. 

3. If you receive a message that WorldShip cannot communicate with UPS, consult the computer 
technical support staff at your company. 

4. For WorldShip Workgroup Administrative workstations: Be aware that the WorldShip database 
will be disconnected if your Workgroup Administrative workstation goes into sleep mode. You 
must close WorldShip on both the Workgroup Administrative and Workgroup Remote 
workstations and relaunch the application to resolve this issue. If necessary, consult your 
computer technical support staff for questions about sleep mode and how to adjust this setting. 

5. If you have a UPS-supplied printer, restart your printer prior to shipping by turning it off and then 
turning it back on. If you are on Microsoft Windows Vista/Windows 7 and you have a UPS-
supplied thermal printer (Eltron®/Zebra®), follow the Installation procedure for new Eltron/Zebra 
drivers. 

Installation Procedure for new Eltron/Zebra drivers: 

Note: The instructions below follow the “default view” format for Microsoft Windows 
Vista/Windows 7. 

Remove current Eltron/Zebra Printers and Drivers. 

1. Click on Start on the Windows taskbar and select Control Panel. 

2. Select View Devices and Printers from the Hardware and Sound section. 

3. Empty the printer queue for each Eltron, Zebra and UPS thermal printer (such as UPS2844, 
etc.). 

4. Go to C:\UPS\WSTD\FOSS\DRIVERS\ELTRON. 

5. Double-click on ZebraUninstaller.exe. 

6. Click on the Analysis button. 
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7. When the analysis is complete, click on Clean. 

8. Click on OK to start the cleaning process. 

9. When the cleaning process is complete, click on OK. The Zebra Uninstaller will automatically 
close. 

Installation Instructions to Install Eltron/Zebra Thermal Label Printers on Microsoft 
Windows Vista/Windows 7 with USB printers: 

1. Plug the USB cable into the computer and printer. Turn on the printer.  

2. Launch WorldShip. 

3. On the Tools menu, select System Preferences Editor and then select the Printing Setup 
tab. 

4. Under Label Printer, click on Label Printer Setup. 

5. Click on Change Label Printer. 

6. Click on Add Printer, choose Eltron/Zebra as your printer type and click on Select. 

7. On the Zebra Printer Driver Installation window, click on Install Zebra Printer. 

8. In the Selecting the printer window, select Zebra from the Manufacturer’s window, and then 
select the printer from the Printers window. Example: Select the Zebra ZP Series-200 dpi 
for the Zebra ZP450. Select UPS Thermal 2844 for the LP2844. Click on Next.  

9. On the Printer Options window, select the correct USB port and language.  

10. Click on the Finish button. Windows will automatically install the printer drivers.  

11. On the Printer Selection window, click on Cancel. 

12. Click on Change Label Printer. 

13. Select the printer name, and then click on Select. 

14. On the Label Printer Setup window, select the printer stock dimensions and extended area 
usage. Click on Apply. 

15. On the Printing Setup window, click on the Doc and Consignee label tick boxes as needed, 
and then click on the OK button. 

16. Turn on the printer. The Found New Hardware wizard appears. 

17. If using Windows XP, select No, not this time and then click on Next.  

18. Select Install the software automatically and click Next.  

19. Allow the software to install and click on Finish.  

Installation Instructions to Install Eltron/Zebra Thermal Label Printers on Microsoft 
Windows Vista/Windows 7 with Serial/Parallel printers: 

1. Plug the serial/parallel cable into the computer and printer. Turn on the printer.  

2. Restart your PC. 

3. Launch WorldShip. 
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4. On the Tools menu, select System Preferences Editor and then select the Printing Setup 
tab. 

5. Under Label Printer, click on Label Printer Setup. 

6. Click on Change Label Printer. 

7. Click on Add Printer, choose Eltron/Zebra as your printer type and click on Select. 

8. On the Zebra Printer Driver Installation window, click on Install Zebra Printer. 

9. In the Selecting the printer window, select Zebra from the Manufacturer’s window, and then 
select the printer from the Printers window. Example: Select the Zebra ZP Series-200 dpi 
for the Zebra ZP450. Select UPS Thermal 2844 for the LP2844. Click on Next. 

10. On the Printer Options window, select the correct port and language. 

11. Click on the Finish button. Windows will automatically install the printer drivers.  

12. On the Printer Selection window, click on Cancel. 

13. Click on Change Label Printer. 

14. Select the printer name, and then click on Select. 

15. On the Label Printer Setup window, select the printer stock dimensions and extended area 
usage. Click on Apply. 

16. On the Printing Setup window, click on the Doc and Consignee label check boxes as 
needed, and then click on the OK button. 

Support Guides 

WorldShip provides a User Guide, Installation Guide and Functions Shortcut Sheet in 
PDF format on ups.com®. 

To view or print these documents, install the free Adobe® Reader® software from adobe.com 
and then follow these steps: 

1. Go to ups.com/worldship. 

2. Select your country/language and then click on Go.  

3. Select Get WorldShip Support under Get Started. 

4. Select View User Guides. 

5. View and print the documents as needed. 


